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Excerpted from

The Little Digital
Camera Book
By Cynthia L. Baron and Daniel Peck

SET THE 
CAMERA
OPTIONS
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Digital cameras include many more options than film cameras do. You can use these features

to compensate for tricky lighting or artificial light, to change the framing with the zoom, and

to choose the type of file the camera will create for each shot.

In this chapter, we cover the most common features. Obviously, not every camera will have

every feature. So your mileage may vary, as the saying goes.
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From     The Little Digital Camera Book

Resolution
On a digital camera, the resolution setting controls both the file type and the size of the

photograph that is saved to the storage card. All cameras can save in JPEG format. Some

also offer the higher-resolution TIFF and RAW formats. Within each format setting, you can

also choose the resolution or number of pixels that the picture will contain. The more pix-

els, the higher the resolution and the larger you can display or print the picture without

compromising quality.

Choosing the Right Resolution for Your Purpose Before you choose the resolu-

tion setting for a photo, consider what you plan to do with the picture. If you plan to print a

shot, you’ll want the highest quality file format (TIFF or RAW). If you plan to display the pic-

ture on a Web page or send it via email, you can use JPEG. 

Next, you choose the resolution. Some cameras have several resolution settings with names

like SHQ (super high quality), also called Fine; HQ (high quality), or Normal; and SQ (standard

quality), or Basic. The resolution setting determines the image size and the amount of infor-

mation the camera saves for each picture. 

You might think that you should simply take all of your pictures at the highest resolution so

you’ll get the best quality. There are several reasons why this is impractical. First, the higher the

resolution, the larger the file size. And the larger the file size, the fewer pictures you’ll be able to

fit on the storage card. For example, if your camera came with an 8 MB or 16 MB card, you

might only be able to save one or two pictures at the highest resolution. Unless you plan to

make a major investment in storage media, and few people do, that’s a pretty big limitation. 

Another reason you won’t want to use the highest resolution is the law of diminishing

returns. If your plan is to ultimately display the photo on your Web site, the higher resolution

is a waste of space, since the extra pixels are going to be thrown away when you reduce the size

of the picture.  

Remember that you can mix file types and sizes on the same card. So you can use different

formats for different pictures just by changing the settings.

Setting Resolution on the Camera Most cameras offer two methods for changing

settings. You can set the most commonly used features, like flash settings, via buttons on the

camera (Figure 4.1). Most of the settings are accessed using a menu. The menu is displayed

on the camera’s LCD display (Figure 4.2). To learn how to specify the settings on your partic-

ular camera, refer to the documentation.

Some cameras have an option that lets you choose whether to have the camera save

your setting changes or return to the defaults when you shut it off.  Check your camera’s

documentation.
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Focus
To get your subject in focus, the camera

lens must be set to the right distance.

Autofocus will give you the right setting

in the vast majority of cases. 

Using Autofocus For most pictures,

you can use the autofocus by pointing

the camera at the subject and simply

pressing the shutter button. The camera

measures the distance to the subject and

adjusts the focus accordingly. What

could be easier? 

Unfortunately, that doesn’t always do the job. There are a few situations in which autofocus

will not work correctly without a little input from the user. If the subject is not in the center of

the frame or there’s an excessively bright object near the center (where autofocus will look to

Optical
viewfinder

Flash settings button

Flash LED

Exposure LED

Macro Focus/Delete button

Menu control buttons

Manual focus button

Display on/off button

Menu button

LCD display

Figure 4.2 Menu choices are displayed

on the screen.

Figure 4.1 Your camera probably lets
you set most features with buttons.
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determine proper focus), then autofocus may not gauge the distance correctly (Figure 4.3).

If you’re not sure that the autofocus is going to know what you’re trying to focus on, tem-

porarily move the camera so that the intended subject is in the center of the frame and hold

the shutter button halfway down to set the focus, Then reframe the shot, and press the but-

ton all the way (Figure 4.4).

Using Manual Focus If your camera offers a manual focus option, you can set the focus

yourself. Since the viewfinder will not always reliably show good focus, you should measure the

distance from the camera to the subject. Then set the focus on the camera to that distance

(Figure 4.5).

Using Macro Focus At normal settings,

the closest you can get to a subject and still

have it in focus is about 10 to 12 inches. When

you want a super-close shot of something like a

flower, you’ll need to set the camera to macro

focus. At this setting, you can get within a cou-

ple of inches and the autofocus will correctly

adjust for that distance (Figure 4.6).

When reviewing your photos, the LCD

display on your camera is too small to

give you a reliable sense of whether a

shot is in focus. Always check the shot on

your computer to make sure that the fine points

like focus are correct. 

Figure 4.3 Setting the focus while aim-
ing at the street and then reframing on
the car prevents the glare on the wind-
shield from throwing the autofocus off.

Figure 4.4 Autofocus focused on the closer car, slightly blurring the background
(left). Setting the autofocus using the background keeps it in focus, but slightly
blurs the car in the foreground (right).
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Exposure
Any camera must be set to allow just the right amount of light

in order to get a properly exposed picture. Fortunately, digital

cameras are very smart and do this automatically. But there are

some situations that call for your input to make a photo come

out the way that you want it to.

Many cameras give you the ability to set shutter speed

(the length of the exposure) and aperture (how much light

is let in for the exposure) manually.

What Does Autoexposure Do? Autoexposure

gauges the proper amount of light required to get a good

shot. As with autofocus, autoexposure will do the job in

most situations; but there are some situations where it won’t

properly gauge the correct exposure. Autoexposure, like aut-

ofocus, uses the center of the frame to measure the light. So

if there is a particularly bright or dark area near the center of

the frame, it will throw the exposure off. 

To compensate, temporarily move the camera so that

the area with the amount of light that you want is in the

center of the frame, and hold the shutter button halfway

down. Then reframe the shot, and press the button all the

way to take the picture (Figure 4.7). 

Figure 4.5 The manual
focus display aids you in set-
ting a proper focus distance.

Figure 4.7 The sun behind the trees caused the autoexposure to underexpose
this shot (left). Aiming the center of the viewfinder at the ground and holding
the shutter button halfway down caused the autoexposure to use the darker area
to set the exposure (right).

Figure 4.6 The camera
was about 3 inches from
the flower and was set to
macro focus.
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Figure 4.8 With a fast shutter speed, the motion of Sarah on the mower is frozen.
With a slower shutter speed, the mower looks like it’s going at a much faster clip.

Setting Shutter Priority Some cameras let you manually set the shutter speed 

while having the autoexposure set the appropriate aperture automatically. You can use this

Shutter Priority option if you’re trying to capture a subject in motion and you want to either

freeze the motion (with a faster shutter) or blur it (with a slower shutter) (Figure 4.8).

Setting Aperture Priority Aperture Priority works much the same as Shutter Priority,

except that you set the f-stop and the camera then chooses the right shutter speed. This can

be useful if you want to increase the depth of field. Because aperture on most digital cameras

doesn’t have as noticeable an effect on depth of field as with a larger camera, this is not a fea-

ture you’re likely to use much.

Using Manual Exposure For the adventurous or advanced photographer, some cam-

eras offer a manual exposure option. You can set both the shutter speed and the aperture

Figures 4.9 Three different manual exposures on the same subject show more
and less light. Shoot it several different ways, and you can then choose the one
that work best. 

 digitalphotobooklet_F2sm  6/17/03  12:16 PM  Page 6



Shoot! Edit! Print! Your complete digital photography guide from Peachpit Press

7Chapter 4Set the Camera Options Continued....

yourself. You’ll have to gauge the proper exposure on your own. You can try taking several

shots at different settings and reviewing each shot on the camera’s display to figure out the

optimum setting (Figure 4.9).

Setting Exposure Compensation If you want to use the autoexposure but still want

a degree of control, some cameras offer exposure compensation. With this feature, you can set

the autoexposure to be slightly lighter or darker to tone down glare in very bright sunlight or

to enhance highlights in deep shade. 

Most exposure compensation controls measure the compensation as positive and negative

decimal numbers. Setting a positive number will make the picture brighter and a negative

number will make it darker (Figure 4.10).

Setting White Balance If you’re shooting in certain kinds of lighting, such as indoors

with artificial light, you can wind up with odd-looking results. Because artificial light has differ-

ent amounts of color than natural light, a shot may wind up looking too red or too green.

Digital cameras have a marvelous feature called white balance that will correct this kind of

problem before it happens. By setting the camera to automatically correct for different types

of light as you shoot, you can get a good-looking photograph without having to do extensive

color correction in your image-editing software.

White balance can be set to correct for:

• Incandescent light • Cloudy outdoor light
• Bright outdoor light (full sunshine) • Fluorescent light

Figure 4.10 The first shot of Dan’s lawn tractor was set with a positive exposure
compensation setting, creating a brighter shot. The middle shot was set with 
no exposure compensation. The last shot was taken with a negative exposure
compensation setting, resulting in a darker image.
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Figure 4.12 Three different views of the same scene, taken in the same spot,
using the zoom to change the framing.

Figure 4.13 Even though the second, digitally zoomed, shot brings Megan and
her friends in closer, it loses detail and sharpness that is there in the first shot.

Most cameras also have an automatic setting that will determine the best white balance

setting. But there are no set rules about white balance. Every camera handles it a bit differently,

so a bit of experimentation will give you a sense of what works best. 

If you’re using a flash to shoot, you may not have to worry about color correction—the flash

will provide properly balanced light. But if the flash will only cover the subject, the background

may still show a color imbalance.  So in that case you’d use the white balance.

Zoom
The ability to zoom is one of the handiest features on a camera. Rather than having to move

yourself closer or farther from a subject, you can use the zoom to change the apparent dis-

tance. So you can make your subject appear to be closer to the camera by zooming in, or you

can widen the field to get more in a shot by zooming out  (Figure 4.12). 

Digital cameras (depending on your model) use optical and/or digital zoom. Optical zoom

uses the lens to magnify the subject and will give you a good photo at full resolution. Digital

 digitalphotobooklet_F2sm  6/17/03  12:16 PM  Page 8



zoom can get you closer to the subject, but it

enlarges the image using the circuitry in the

camera, much the way you’d enlarge it using

image editing software—and with the same

effect. Digital zoom results in a lower-quality

picture (Figure 4.13). The bottom line is that

you should stick with optical zoom unless it’s

absolutely necessary to get a closer shot. 

Using Optical Zoom The zoom control allows you to reframe a shot without moving. This is

incredibly convenient and is thus a feature that you’ll use a lot. You can change from a wide angle to

a close-up without moving an inch. Typically, you’ll find the zoom control on the top of the camera.

Just look through the viewfinder (or LCD display), and push the zoom button to move in or out.

Using Digital Zoom Most digital cameras with both optical and digital zoom are set to

use the optical zoom by default. If you find that you want to get a closer shot, you can change

the setting to keep going beyond the optical zoom’s range. As you zoom, the display will indi-

cate where optical zoom stops and digital zoom begins (Figure 4.14).

Flash
When there isn’t enough available light to take a good picture, the camera needs help, in the

form of a flash. The flash adds enough light to give the proper exposure. 

Most cameras will automatically use the flash when they detect that more light is required.

Most cameras have an indicator light that lets you know that the flash is ready. After you use

the flash on a shot, there will usually be a few seconds’ delay while the flash recharges. 

When using the flash, keep in mind that most flashes don’t throw their light more than 10

or 15 feet. Anything beyond that range will not get enough light for a proper exposure.

Reducing Red Eye One of the problems that arise when you’re shooting a portrait shot

with flash is the dreaded “red-eye” effect. When the flash goes off, the human eye’s iris

reflects the flash as a bright red. Since you generally don’t want a subject to look like a movie

monster, this is not good. Most cameras offer a red-eye reduction flash setting. This setting

will fire the flash twice, once to let the subject’s eye adjust to the light (which eliminates the

red eye) and then again a second later when the picture is actually taken. Make sure when

using the red-eye setting that your subject knows that the flash will fire twice, so they don’t

move between flashes. 

Red eye can be corrected on your com-

puter with image-editing software, but it’s

preferable to eliminate it at the source. 

Some cameras have an external flash

option. This is a jack where you can plug

in a separate, more powerful flash unit.

Shoot! Edit! Print! Your complete digital photography guide from Peachpit Press
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Figure 4.14 The zoom indicator shows
you when you’ve gone past optical
zoom territory and into digital zoom.
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Using the Flash to Fill In Light When shooting a subject in shadows, you might

sometimes want just a bit of flash to bring out the darker areas without making everything too

bright. Fill flash is the answer. When set to fill flash, the camera uses a reduced amount of flash,

which is usually just enough to bring out the details in the darker areas (Figure 4.16).

Shooting without the Flash Most cameras give you the option to suppress the flash. If

there isn’t sufficient light to get a good exposure but you don’t want to use a flash, you can turn

it off entirely. The camera will adjust the exposure setting accordingly. This setting can come in

handy in, say, a museum that doesn’t allow flash photography. It will also be useful if the subject

is behind or near a shiny surface that will reflect too much light in the shot (Figure 4.17).

But there’s a catch. (Isn’t there always?) In low light and with no flash, the shutter speed may

be so slow that the shot will come out blurred. As a rule, any shutter speed slower than 1/30th

of a second will be blurred if you’re holding the camera. As long as your subject doesn’t move,

you can overcome this problem by using a tripod or monopod. This will generally keep the

camera steady enough get a clear shot even at low shutter speed (Figure 4.18).

Figure 4.17 The glare of the flash
on the glass washes out this shot 
of a poster.

Figure 4.18 Turning the flash off and
using a monopod to hold the camera
steady results in a good, sharp shot.

From     The Little Digital Camera Book
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Figure 4.16 With no
flash, the darker
areas like the hair
lack detail. By
adding some fill
flash, there’s enough
light to see the
shadow details with-
out washing out the
brighter areas.
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This should be called “The Kevin Ames Chapter.” Actually, it really should be called the 

“I Hate Kevin Ames Chapter” because I already had this entire chapter written, until I stopped

by Kevin’s studio in Atlanta one night to show him the rough draft of the book. What should

have been a 15-minute visit went on until after midnight, with him showing me some amazing

portrait retouching tricks for the book. So  I had to go back home and basically rewrite,
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Step Two: 
Go under
the Filter
menu,
under Blur,
and choose
Gaussian
Blur. When
the Gauss-
ian Blur
dialog
appears, drag the slider all the way to the
left, and then drag it slowly to the right
until you see the acne blurred away. The
photo should look very blurry, but we’ll fix
that in just a minute, so don’t let that throw
you off—make sure it’s blurry enough that
the acne is no longer visible

12 Chapter 6 Head Games Retouching Portaits

From The Photoshop Book For Digital Photographers

update, and tweak the entire chapter. Which I can tell you, is no fun once you think a chapter

is done and you’re about a week from deadline, but the stuff he showed me was so cool, I

literally couldn’t sleep that night because I knew his techniques would take this chapter to 

the next level. And even though Kevin was incredibly gracious to let me share his techniques

with my readers (that’s the kind of guy Kevin is), there was no real way I was going to name 

this chapter “The Kevin Ames Chapter.” That’s when it became clear to me— I would have 

to kill him. But then I remembered Kevin had mentioned that Jim DiVitale had developed

some of the techniques that he had showed me, so now it was going to be a double murder. 

I thought, “Hey, they both live in Atlanta, how hard could this be?” But the more I thought

about it, what with having to fly back up there and having to fly on Delta (stuffed in like

human cattle), I figured I’d just give them the credit they deserve and go on with my life. 

Thus far, it’s worked out okay.

Lessening Freckles or Facial Acne 
This technique is popular with senior class portrait photographers who need to lessen or

remove large areas of acne, pockmarks, or freckles. This is especially useful when you have a lot

of photos to retouch (like a senior portrait retoucher) and don’t have the time to use the

methods shown previously, where you deal with each blemish individually.

Step One: Open the photo that
you need to retouch.
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Step Three:  Go under the Window menu and choose History to bring up the His-
tory palette. This palette keeps track of the last 20 things you’ve done in Photo-
shop. If you look in the list of steps (called “History States”), you should see two
States: the first will read “Open” (this is when you opened the document), and
the second will read “Gaussian Blur” (this is where you added the blur).

Step Four: Click on the Open State to return your photo to what it looked like when
you originally opened it (as shown at left). The History palette also works in conjunction
with a tool in the Toolbox, called the History Brush. When you paint with it, by default
it paints back to what the photo looked like when you opened it. It’s like “Undo on a
brush.” That can be very handy, but the real power of the History Brush is that you can
have it paint from a different State. You’ll see what I mean in the next step.
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Step Five: In the History palette, click in the
first column next to the State named “Gauss-
ian Blur.” If you painted with the History
Brush now, it would paint in what the photo
looked like after you blurred it (which would
do us no good), but we’re about to fix that.

Step Six: To keep from simply painting in a blurry version of our photo, go up to
the Options Bar and change the History Brush’s Blend Mode to Lighten. Now
when you paint, it will affect only the pixels that are darker than the blurred
state. Ahhh, do you see where this is going?

Step Seven: Now you can take the History Brush and paint over the acne areas, and
as you paint you’ll see them diminish quite a bit (as shown at right). If they diminish
too much, and the person looks “too clean,” undo your History Brush strokes, then
go up to the Options Bar and lower the Opacity of the brush to 50% and try again. 

Before After
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Pro Wrinkle Removal
The Healing Brush and Patch tools are pretty amazing for removing wrinkles, but the problem

may be that they do just that—they completely remove wrinkles. Depending on the age of the

subject you’re retouching, the photo may look obviously retouched (in other words, if you’re

retouching someone in their 70s and you make them look as if they’re 20 years old, it’s just

going to look weird). Here’s a simple trick Kevin Ames uses for more realistic healing.

Step One: Open the photo you want to
“heal.”

Step Two: Duplicate the Background layer in the Layers palette by pressing Com-
mand-J (PC: Control-J). You’ll perform your “healing” on this duplicate layer.

Step Three: Use the Healing Brush to
remove the wrinkled area. As you can
see, with every wrinkle removed, this
photo looks obviously retouched.
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Step Four: Go to the Layers palette and
reduce the Opacity of this layer to bring
back some of the original wrinkles.
What you’re really doing here is letting
a small amount of the original photo
(on the Background layer, with all its
wrinkles still intact) show through. Keep
lowering the Opacity until you see the
wrinkles so they’re visible but not
nearly as prominent.

Step Five: Here’s the final retouch with
the Opacity of the healed layer lowered
to 47% so I’m getting just a little more
than half the wrinkles back, and the
photo looks much more realistic.
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Colorizing Hair 
This technique (that I learned from Kevin Ames) gives you maximum control and flexibility

while changing or adjusting hair color, and because of the use of Layer Masks and an

Adjustment Layer, you’re not “bruising the pixels.” Instead, you’re following the enlightened

path of “non-destructive retouching.” 

Step One: Open
the photo you
want to retouch.

Step Two: Choose Color Balance from
the Adjustment Layer pop-up menu at
the bottom of the Layers palette.
When the dialog appears, move the
sliders toward the color you’d like as
the hair color. You can adjust the
shadows, midtones, and highlights by
selecting each in the Tone Balance
section of the Color Balance dialog
and then moving the color sliders. 
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Step Three: In this case, we want to make the hair
more red, so we’ll move the top slider toward Red
for the shadows, then the midtones, and then the
highlights. Now, click OK, and the entire photo will
have a heavy red cast over it (as shown).

Step Four: Press “x” until
your Foreground color is
black, and press Option-
Delete (PC: Alt-Backspace)
to fill the Color Balance
mask with black. Doing so
removes the red tint from
the photo. 

From The Photoshop Book for Digital Photographers

18 Chapter 6 Head Games Retouching Portaits  

Step Five: Get the Brush tool in the Toolbox, choose a soft-edged brush, press “d” to
set your Foreground color to white, and begin painting over her hair. As you paint,
the red tint you added with Color Balance is painted back in (as shown in left image).

Step Six: Continue painting on the
hair until it’s fully tinted (far left).
You may want to paint a few
strokes over her eyebrows as well.
Once the hair is fully painted,
change the Blend Mode of your
Color Balance Adjustment Layer to
Color, and then lower the Opacity
until the hair color looks natural
(as shown to right)
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Whitening the Eyes Quick Trick 
This is a great little technique for quickly whitening the whites of the eyes, and it has the added

benefit of removing any redness in the eye along the way.

Step One: Open the portrait you want to retouch.

Step Two: Choose the Lasso tool from the Toolbox
and draw a selection around the whites of one of
the eyes. Hold the Shift key and draw selections
around the whites of the other eye, until all the
whites are selected in both eyes. 

Step Three: Go under the Select menu and choose Feather. You’ll need to use Feather
to soften the edges of your selection so your retouch isn’t obvious. In the Feather
Selection dialog, enter 2 pixels and click OK.
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Step Six: Click OK in the Hue/Saturation dialog to apply your adjustments, and then
press Command-D (PC: Control-D) to deselect and complete the enhancement.

Step Five: While you’re still in the Hue/Saturation dialog, from the Edit menu
switch back to Master. Drag the Lightness slider to the right to increase the
lightness of the whites of the eyes.

Step Four: Go under the Image menu, under Adjustments, and choose Hue/Satu-
ration. When the Hue/Saturation dialog appears, choose Reds from the Edit pop-
up menu at the top (to edit just the reds in the photo). Now, drag the Saturation
slider to the left to lower the amount of saturation in the reds (which removes
any bloodshot appearance in the whites of the eyes). 
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Step Three: Go under the Select menu
and choose Feather. When the Feather
Selection dialog appears, enter 1 pixel
and click OK to smooth the edges of
your selection. That way, you won’t see
a hard edge along the area you selected after you’ve whitened the teeth.
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Whitening Teeth
This really should be called “Removing Yellowing, Then Whitening Teeth” because almost

everyone has some yellowing, so we remove that first before we move on to the whitening

process. This is a simple technique, but the results have a big impact on the overall look of the

portrait, and that’s why I do this to every single portrait where the subject is smiling.

Step One: Open the photo you need to retouch.

Step Two: Switch to the Lasso tool, and carefully draw a selection around the
teeth, being careful not to select any of the gums (as shown here).
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Step Five: Now that the yel-
lowing is removed, switch the
Edit pop-up menu back to
Master, and drag the Lightness
slider to the right to whiten
and brighten the teeth. Be
careful not to drag it too far,
or the retouch will be obvious.

Step Six: Click OK in the
Hue/Saturation dialog, and your
enhancements will be applied.
Last, press Command-D (PC:
Control-D) to deselect and see
your finished retouch (shown
here).

Step Four: Go under the Image
menu, under Adjustments, and
choose Hue/Saturation. When
the dialog appears, choose
Yellows from the Edit pop-up
menu at the top. Then, drag
the Saturation slider to the left
to remove the yellowing from
the teeth. 
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Excerpted from

Start with 
a Digital
Camera
By John Odam

DIRECT 
DIGITAL 
OUTPUT
Black-and-White Laser Printers Once the proud standard-bearer of the desktop

publishing revolution of the 1980s, the desktop laser printer has been overshadowed by the

recent rise of inkjet printing, and is now often relegated to printing e-mails and correspon-

dence. But its rapid printing rate and use of plain paper still make it an economical means of

producing flyers, factsheets, and other documents.
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In principle, a laser printer is similar to a photocopier:

toner particles are attracted to an electrostatically charged

drum that has been sensitized by a light source. The toner is

transferred to a passing sheet of paper, then fused to the

paper by passing over a heated fixing roller.

The light source is a laser beam that scans the image line-

by-line onto the light-sensitive drum while the drum is

rotated in steps. The printer waits until the entire drum is

exposed before printing a page. Duplicate pages emerge rap-

idly once the first one has been printed.

Resolution Requirements For a 600–1200 dot-per-

inch laser printer, optimum resolution for digital photographs

should be 200–300 pixels per inch. It’s important to obtain

this resolution by reducing the dimensions of the image captured by the digital camera, rather

than resampling it.

How to Get the Best Results Laser printing, which is based on graphic arts halftone

imaging techniques, is not particularly flattering to digital camera images. You can improve

the image quality by reducing the dimensions of the images, and by using special coated paper

to obtain better toner coverage. You can also adjust the printer’s dot pattern parameters. 

Printer Software Some printing software allows you to change the frequency of the dot

pattern of the laser print. A finer dot pattern will bring out more detail in the image but will

produce a reduced number of gray tones. Too few levels of gray will result in banding, which

resembles posterization.  Do you need to convert color images to black and white?

You need not convert color files to grayscale to print them on a black-and-white laser

printer. The image quality of grayscale and color images is identical when printed on most

laser printers. But because of the extra operations that the printer’s processor has to perform

Looking at laser print detail
A laser print breaks down a continuous
tone image into a diagonal pattern of
black dots. The way in which the toner
particles are transferred, then fused into
the paper, produces rather fuzzy dots
that tend to degrade the image.
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to deal with a color image, it will take much longer to print a color image than a grayscale

image. 

Color Laser Printers Unlike the ubiquitous standard laser printer, the color laser printer

is a somewhat rarer beast in offices and homes. It uses the same basic technology as the black-

and-white laser printer to create images on a light-sensitive electrostatic drum, but it requires

four drums and four toner reservoirs in each of the four primary process colors: Cyan,

Magenta, Yellow, and Black (CMYK). Many color laser printers also double as color photo-

copiers, or are essentially color photocopiers with a computer rip attachment. One of the

great advantages of laser printers is their speed in reproducing multiple copies. Although it

may take a few minutes for the first print to emerge, subsequent prints will follow in rapid suc-

cession. For this reason, color laser printers are a very efficient and cost-effective means of

reproducing digital color documents in quantities up to 1000.

Most duplication services offer color laser printing, often using the same equipment as for

color copies. Although desktop models are available, they can cost more than 10 times as

much as an inkjet printer.

Resolution for Color Laser The resolution requirements of color laser printers are the

same as for black-and-white laser printers. But because four different halftone dot patterns are

superimposed on the paper, then fused into it as the paper passes through the fixing assembly,

the dots tend to run together and look more like a continuous-tone image.

Inkjet Printers Introduced in the 1980s as a low-cost alternative to the laser printer, inkjet

printers have remained popular because they produce color images. Although the printers them-

selves are quite cheap, ink and paper are not. A year’s supply of ink and paper may exceed the cost

of the printer! 

Low speed is the principal drawback of an inkjet printer. Whereas a laser printer coats an

electrostatically charged drum with toner, then transfers the image quickly to the paper, an

inkjet printer builds the image line by line by aiming microscopic bursts of ink directly at the

paper. This meticulous printing method rules out the inkjet printer as a means of high-quan-

tity reproduction.

What inkjet printers lack in speed is gained in quality. Their reproduction of digital photo-

graphs is superb. In fact, it can be difficult to tell the difference between an inkjet print of a

digital photo and a high-quality photographic print. They are also capable of printing onto

many different media, such as textured paper and fabric.

Making Prints with Ink Inkjet printers deliver ink to paper in various ways. The pattern

of ink distribution can be either stochastic, like a Pointillist painting by Seurat, for example, or

rasterized, like the mosaic of dots on a TV screen. 

Depending on the type of inkjet printer, ink is propelled either by a burst of heat or by the

vibration of a piezoelectric element. The tiny nozzles that deliver the ink to the paper are arrayed
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in clusters on the print head assembly. The quantity of ink

emitted is controlled by the printer’s image processor and by

the driver software. The driver software determines which

nozzles are fired, and when. By making two passes, the print

heads can produce an image of very high resolution. 

You should avoid getting fingerprints on the paper

when feeding it into the printer because skin oil will repel

the ink. Prints should also be handled with care because

the ink smudges easily.

Resolution Requirements The resolution requirements for inkjet printers are some-

what lower than for laser printers. A good inkjet print can be made from a digital photograph

at resolutions as low as 144 pixels per inch.

Paper Type The type and quality of the paper significantly affects the appearance of the

print and color accuracy. Matte papers give more natural highlights and glossy papers give

brighter colors and richer blacks. For best results, use paper made by your printer manufac-

turer, and be careful to select the correct paper type in your printer driver.

Creative Ways of Using Digital Prints

Creating Cards, Envelopes, and Gift Wrapping Inkjet prints of digital photos with

a little typesetting make attractive cards. Family pictures and photos from trips and vacations are an

obvious choice, but you can also select favorite things and details from your environment. Prints can

be folded and placed in envelopes, or images can be paired up and cut in two to make postcards.

Digital photos of patterns and textures make wonderful gift wraps and envelopes. With a

color printer that can print on various kinds of paper you can use your digital camera in com-

From Start With a Digital Camera
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Making greeting cards A trip to your
local botanical gardens with a digital
camera can yield a fine crop of greeting
cards. These cards are printed on 8 1/2" X
11" sheets of paper, folded to 5 1/2"X 
8 1/2". The layout is a simple 1-page
document with 1/2" margins all round,
with one digital photo cropped to 
7 1/2" X 4 1/2" positioned at one end of
the sheet.
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bination with your printer as a starting point for personalized gift items. I recommend thin

paper because it’s easy to fold.

Many digital cameras will not produce images that are big enough to cover a full 

8 1/2" X 11" sheet of paper without enlargement. If you have scruples about printing digital

images when they are enlarged, you might consider using a seamless tile technique.

Quality Digital Prints
Printing on Fabric and Art Papers As an alternative to printing on regular paper, you

can try out other types of paper and fabric for your digital photography prints. As a rule, toner-

based laser printers will not tolerate paper with a rough surface, and have difficulty printing on

heavy or stiff papers. Inkjet printers, however, will accept many different types of paper because their

printing mechanism never comes into direct contact with the paper. They will even print on fabric.

Using a nonstandard printing paper can produce a unique and visually appealing effect, but

there are some disadvantages, too. Traditional art papers cause a faster ink degradation than a

standard inkjet paper, although this can be overcome to a certain extent by spraying on an

ultraviolet coating, or by using special inks. Bear in mind, however, that anything other than

pure white paper will give inaccurate color reproduction.

Types of Art Paper An inkjet printer will accept almost any type of art paper including

Strathmore, Canson, and various watercolor papers. In addition, utility papers such as

newsprint, brown wrapping paper, and thin packing carton paper can be used. More absorbent

papers will impair the definition of the image. For the most part, these types of papers are for

graphic effect rather than faithful reproduction. The farther a specialty paper is from a smooth

white sheet, the more your photography will be altered by being printed on it.

Types of Fabric If your printer will accept heavy paper, it will also accept fabric such as silk, linen,

and canvas. Textured fabrics such as canvas should be fine-grained and very thin for best results.

Size Limitations While most digital cameras generate a crisp inkjet print at 8" X 10", fur-

ther enlargement can cause deterioration. You can produce a larger print, however, by splicing

together a panorama from a mosaic of several digital photographs. On a standard desktop

inkjet printer the 8" limitation applies only to the width of the paper. If you use a roll of paper

or fabric, the print can be any length.

There are also inkjet printers available that produce prints of 11" X 17" and beyond, but these

printers should be used only for output from cameras with a resolution of greater than 4 megapixels.

How Many Colors? Most inkjet printers use four ink colors to reproduce color photo-

graphs, but some models use six or more inks to do the same job. Secondary colors such as

orange, green, violet, and indigo are added to the basic primaries of cyan, magenta, yellow, and

black. In spite of the increase in color range, multiple-ink printers seem to offer no significant
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advantage as yet, but advances in ink

technology could change this.

Archival Issues Standard inkjet

printer inks may fade when exposed to

daylight. Paper will also react with the ink

and deteriorate over time. If you are con-

cerned with permanence—and if you sell

your work you should be—you should

use archival-quality materials. Best results come from

paper and inks produced by the same printer manufac-

turer so that the chemical interaction of ink and paper

is properly balanced to give a more stable print. The

relative stability of inkjet output varies considerably

from manufacturer to manufacturer, and even within

models of the same make.

In contrast to inkjet output, prints from toner-based printers, such as the Fiery/Canon, are

relatively stable, although their color accuracy is not yet as good as inkjet prints.

Permanent Inks Standard inks are dye-based. Dyes are liquids that come in vivid, trans-

parent colors. Unfortunately, dyes are fugitive—they lose their intensity over time by chemi-

cal reaction with air and light. 

Specialized permanent inks that are pigment-based are available, although they are consid-

erably more expensive than regular inks. Pigments consist of opaque particles that are ground

into an extremely fine powder and suspended in a liquid medium. Pigments reproduce a nar-

rower range of colors than dyes. The relative permanence of pigment-based inks should be

weighed against the loss of color gamut and the considerable increase in cost.

Protective Coatings An economical way to gain more permanence with standard inks

is to apply a protective coating. Spray-on varnishes that contain ultraviolet-filtering chemi-

cals are quite effective in slowing the degradation of dye-based inks and do not significantly

affect colors. As with all sprayed products, be sure not to inhale the chemicals, working out-

of-doors where possible.

Changing paper Inkjet printing on
watercolor paper and packing car-
ton paper make interesting alterna-
tive ways of presenting digital
photographs.

From Start With a Digital Camera
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